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0.1 CE103 Algorithms and Programming I
0.1.1 Week-2

0.1.1.1 Software Development Environments Download DOC1, SLIDE2, PPTX3

0.1.1.2 Outline

• Flowgorithm
• Introduction to Analysis of Algorithms
• Programming Environment Setup and Configuration

– C/C++ (DevCpp,Code Blocks,MinGW,LLVM,VsCode,VisualStudio,Notepad++,Vi/Vim,Eclipse,Netbeans,Cmake/Make)
– Java (VsCode,Notepad++,Eclipse,Netbeans,Cmake)
– C# (VsCode,Notepad++,VsCode,VisualStudio,Cmake)

1ce103-week-2-setup.en.md_doc.pdf
2ce103-week-2-setup.en.md_slide.pdf
3ce103-week-2-setup.en.md_slide.pptx
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0.1.1.3 Outline

• Common Tools and Platforms
– Fatih Kalem, Notepad++,HxD, MarktextApp,Cygwin,Dependency Walker,Doxygen,Sonarlint,

Codepen.io, Codebeautify.org, Codeshare.io,AsciiFlow.com, Freemind, Mockflow, Wireflow, Plan-
tUML,Drawio,Putty, MobaXterm,Teamviewer,AnyDesk,Paletton.com,Colorhunt.co,Understand,JD
Project,Cutter,IDA Pro / Freeware,pythontutor,godbolt,scrcpy,Travis-CI,AppVeyor,Jenkins,Vagrant,Docker
/ Docker Compose / Kubernetes,Nuget,SCV Cryptomanager,Addario CryptoBench,Raymond’s
MD5 & SHA Checksum Utility,SlavaSoft HashCalc,Portable PGP, and more …

0.2 Algorithm Basics

0.2.1 Flowgorithm (1)

• http://www.flowgorithm.org/

• Flowgorithm - Documentation4

• https://github.com/timoteoponce/flowgorithm-examples

0.2.1.1 Flowgorithm (2)

• Main Window

4http://www.flowgorithm.org/documentation/index.html
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0.2.1.2 Flowgorithm (3)

• Console Window
– The classic method to interact with the computer is to use the “Console”. Flowgorithm attempts

to make it look like a typical instant messenger window. The “chat bubbles” are color coded to
match the Input and Output shapes used in the flowchart. If you don’t want to use the chat
bubbles, you can also toggle between them and the classical plain text.

0.2.1.3 Flowgorithm (4)

• Console Window

0.2.1.4 Flowgorithm (5)

• Source Code Viewer Window
– The Source Code Viewer can convert your flowchart to several major programming languages. So,

if you planning to learn a high-level language, then this feature should help you along the way.

0.2.1.5 Flowgorithm (6)

• Source Code Viewer Window
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0.2.1.6 Flowgorithm (7)

• Variable Watch Window
– The variable watch window is used to keep track of how your variables are changing as your

program executes. Each variable is color-coded based on its data type. At a glance, you can tell
exactly what type of data is being stored - and catch where you may want to use a different data
type.

0.2.1.7 Flowgorithm (8)

• Variable Watch Window
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0.2.1.8 Flowgorithm (8)

• More Resources for Flowgorithm
– Flowgorithm Tutorial - TestingDocs.com5

0.2.2 Pseudocode (1)

• Algorithm design language

– Pseudocode - Wikipedia6

– Pseudocode Examples7

– How to write a Pseudo Code? - GeeksforGeeks8

0.2.3 Introduction to Analysis of Algorithms

• In this course, we will learn how to code with several development environments and next term we will
see an analysis of algorithms in detail.

• This topic is covered in the following link:
5https://www.testingdocs.com/flowgorithm-flowchart-tutorial/
6https://en.wikipedia.org/wiki/Pseudocode
7https://www.unf.edu/~broggio/cop2221/2221pseu.htm
8https://www.geeksforgeeks.org/how-to-write-a-pseudo-code/
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– CE100 Introduction to Analysis of Algorithms9

0.2.4 Programming Environment Setup and Configuration

• Programming life is not about only learning how to code. Mostly you need to use several code devel-
opment environments and you need to learn how to use them efficiently.

0.2.5 C / C++ Environment and Development

0.2.5.1 DevCpp (Install / Compile / Run / Debug) (1)

• Download DevC++ IDE from the following link
– https://www.bloodshed.net/

0.2.5.1.1 DevCpp (Install / Compile / Run / Debug) (2)

• Open DevC++ IDE for C Project Generation Open File->New->Project

0.2.5.1.2 DevCpp (Install / Compile / Run / Debug) (3) Select Console Application from
Basic tab and with C Project Option and write a project name such as “Hello” then press OK

Select a folder and save Hello.dev project file.

0.2.5.1.3 DevCpp (Install / Compile / Run / Debug) (4)

• You will see a sample main with an empty body
9https://ucoruh.github.io/ce100-algorithms-and-programming-II/week-1/ce100-week-1-intro/
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0.2.5.1.4 DevCpp (Install / Compile / Run / Debug) (5)

#include <stdio.h>
#include <stdlib.h>

/* run this program using the console pauser or add your own getch, s,ystem("pause") or input loop */
int main(int argc, char *argv[]) {

retAdd 0;
}

0.2.5.1.5 DevCpp (Install / Compile / Run / Debug) (6)

• Add the following line in the main function. This will write “Hello, World!” on the screen and then
wait for a keypress to exit from the application

#include <stdio.h>
#include <stdlib.h>

/* run this program using the console pauser or add your own getch, system("pause") or input loop */

int main(int argc, char *argv[]) {
printf("Hello, World!");
getchar();
return 0;

}

0.2.5.1.6 DevCpp (Install / Compile / Run / Debug) (7)

• Then save the file
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0.2.5.1.7 DevCpp (Install / Compile / Run / Debug) (8)

• Use from menu Execute->Compile F5 to generate Hello.exe
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0.2.5.1.8 DevCpp (Install / Compile / Run / Debug) (9)

• You can find the generated Hello.exe path from Compile.log as follow. Check the Output Filename

Compiling project changes...
--------
- Project Filename: E:\UgurCoruh\RTEU\Lectures\2021-2022 Güz CE103 - Algorithms and Programming I\Lectures\ce103-algorithms-and-programming-I\Week-2\devcpp-hello-world-apps\Hello.dev
- Compiler Name: TDM-GCC 4.9.2 64-bit Release

Building makefile...
--------
- Filename: E:\UgurCoruh\RTEU\Lectures\2021-2022 Güz CE103 - Algorithms and Programming I\Lectures\ce103-algorithms-and-programming-I\Week-2\devcpp-hello-world-apps\Makefile.win

Processing makefile...
--------
- Makefile Processor: C:\Program Files (x86)\Dev-Cpp\MinGW64\bin\mingw32-make.exe
- Command: mingw32-make.exe -f "E:\UgurCoruh\RTEU\Lectures\2021-2022 Güz CE103 - Algorithms and Programming I\Lectures\ce103-algorithms-and-programming-I\Week-2\devcpp-hello-world-apps\Makefile.win" all

gcc.exe -c main.c -o main.o -I"C:/Program Files (x86)/Dev-Cpp/MinGW64/include" -I"C:/Program Files (x86)/Dev-Cpp/MinGW64/x86_64-w64-mingw32/include" -I"C:/Program Files (x86)/Dev-Cpp/MinGW64/lib/gcc/x86_64-w64-mingw32/4.9.2/include"

gcc.exe main.o -o Hello.exe -L"C:/Program Files (x86)/Dev-Cpp/MinGW64/lib" -L"C:/Program Files (x86)/Dev-Cpp/MinGW64/x86_64-w64-mingw32/lib" -static-libgcc

Compilation results...
--------
- Errors: 0
- Warnings: 0
- Output Filename: E:\UgurCoruh\RTEU\Lectures\2021-2022 Güz CE103 - Algorithms and Programming I\Lectures\ce103-algorithms-and-programming-I\Week-2\devcpp-hello-world-apps\Hello.exe
- Output Size: 128,103515625 KiB
- Compilation Time: 2,13s

0.2.5.1.9 DevCpp (Install / Compile / Run / Debug) (10)

• Then you can run with Execute->Run F10 or Directly Compile&Run F11
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0.2.5.1.10 DevCpp (Install / Compile / Run / Debug) (11) for debugging operations, just change
the code and add more statements as follow

#include <stdio.h>
#include <stdlib.h>

/* run this program using the console pauser or add your getch, system(",pause") or input loop */

int main(int argc, char *argv[]) {

printf("Hello, World! Step-1\n");
printf("Hello, World! Step-2\n");
printf("Hello, World! Step-3\n");
printf("Hello, World! Step-4\n");
printf("Hello, World! Step-5\n");
printf("Hello, World! Step-6\n");

getchar();

return 0;
}
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0.2.5.1.11 DevCpp (Install / Compile / Run / Debug) (12) Click on line numbers and add
breakpoints for the debugger. This red point will be debugger stop points

0.2.5.1.12 DevCpp (Install / Compile / Run / Debug) (13)

• In the menu section, select the compiler with debug option

0.2.5.1.13 DevCpp (Install / Compile / Run / Debug) (14)

• Compile application with debugging setting and in Execute Section use Debug F5 to start debugging
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0.2.5.1.14 DevCpp (Install / Compile / Run / Debug) (15)

• The debugger will stop at the breakpoint at the debug point (blue line)
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0.2.5.1.15 DevCpp (Install / Compile / Run / Debug) (16)

• Moving to the next statement can be done via control buttons or shortcuts

0.2.5.1.16 DevCpp (Install / Compile / Run / Debug) (17) -Press F8to step-by-step continue
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• Then go to Project Options -> Compiler -> Linker and set Generate debugging information to
“yes”, and make sure you are not using any optimization options (they’re not good for debug mode).
Also, check the Parameters tab, and make sure you don’t have any optimization options (like -O2 or
-O3, but -O0 is ok because it means no optimization) or strip option (-s).

0.2.5.1.17 DevCpp (Install / Compile / Run / Debug) (18)

• After that, do a full rebuild (Ctrl-F11), then set a breakpoint(s) where you want the debugger to stop
(otherwise it will just run the program). To set a breakpoint on a line, just click on the gutter (the
gray band on the left), or press Ctrl-F5.

0.2.5.1.18 DevCpp (Install / Compile / Run / Debug) (19)

• Now you are ready to launch the debugger, by pressing F8 or clicking the debug button. If everything
goes well, the program will start, and then stop at the first breakpoint. Then you can step through
the code, entering function calls, by pressing Shift-F7 or the “step into” button, or stepping over the
function calls, by pressing F7 or the “next step” button. You can press Ctrl-F7 or the “continue”
button to continue execution till the next breakpoint. At any time, you can add or remove breakpoints.

0.2.5.1.19 DevCpp (Install / Compile / Run / Debug) (20) When the program stopped at a
breakpoint and you are stepping through the code, you can display the values of various variables in your
program by putting your mouse over them, or you can display variables and expressions by pressing F4or
the “add watch” button and typing the expression.

0.2.5.1.20 DevCpp (Install / Compile / Run / Debug) (21) How do I debug using Dev-C++10

0.2.5.2 Code Blocks (Install / Compile / Run / Debug) (1) Download Code Blocks from the
following link

Binary releases - Code::Blocks11

0.2.5.2.1 Code Blocks (Install / Compile / Run / Debug) (2) Open Code Blocks and

Select File->New->Project
10http://eilat.sci.brooklyn.cuny.edu/cis1_5/HowToDebug.htm
11https://www.codeblocks.org/downloads/binaries/
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0.2.5.2.2 Code Blocks (Install / Compile / Run / Debug) (3) Select Console Application

Click Next from Opening Window
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0.2.5.2.3 Code Blocks (Install / Compile / Run / Debug) (4) Select C for Sample Project
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0.2.5.2.4 Code Blocks (Install / Compile / Run / Debug) (5) Write a project name and title also
set a project folder
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0.2.5.2.5 Code Blocks (Install / Compile / Run / Debug) (6) Select a compiler for this project
we selected GCC but you can select C compilers from the list. Set Debug and Release executable output
folders.
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0.2.5.2.6 Code Blocks (Install / Compile / Run / Debug) (7)

• After this wizard, you will have the following code

#include <stdio.h>
#include <stdlib.h>

int main()
{

printf("Hello world!\n");
return 0;

}

0.2.5.2.7 Code Blocks (Install / Compile / Run / Debug) (8) Select Debug Build from the menu
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0.2.5.2.8 Code Blocks (Install / Compile / Run / Debug) (9) Run with Build and Run F9

0.2.5.2.9 Code Blocks (Install / Compile / Run / Debug) (10)

• You should see the following output
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0.2.5.2.10 Code Blocks (Install / Compile / Run / Debug) (11)

• Add the following lines to your source code for debugging

#include <stdio.h>
#include <stdlib.h>

int main()
{

printf("Hello world! Step-1\n");
printf("Hello world! Step-2\n");
printf("Hello world! Step-3\n");
printf("Hello world! Step-4\n");
printf("Hello world! Step-5\n");
printf("Hello world! Step-6\n");
return 0;

}

0.2.5.2.11 Code Blocks (Install / Compile / Run / Debug) (12)

• and add breakpoints with F5 or mouse click

23



0.2.5.2.12 Code Blocks (Install / Compile / Run / Debug) (13)

• select Debug->Start/Continue to start debugger
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0.2.5.2.13 Code Blocks (Install / Compile / Run / Debug) (14)

• If you see the following error this is related to long or turkish characters including the path. Just move
the project to a shorter path and try again

Setting breakpoints
Debugger name and version: GNU gdb (GDB) 8.1
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Starting the debuggee failed: No executable specified, use `target exec'.
Debugger finished with status 0

0.2.5.2.14 Code Blocks (Install / Compile / Run / Debug) (15) You will see the following yellow
pointer for the debugger

0.2.5.2.15 Code Blocks (Install / Compile / Run / Debug) (16) You can use the following menu
or shortcuts for step-by-step debugging.

0.2.5.3 GCC/G++ Complier (MinGW) / Clang-cl (LLVM) (1) Download and install MinGW or
LLVM compiler (if you downloaded then skip this step)

• MinGW installer (clang)

– Download MinGW-w64 - for 32 and 64-bit Windows from SourceForge.net12

• If you have a problem try ‘Github“ builds

– https://github.com/niXman/mingw-builds-binaries/releases
– https://github.com/niXman/mingw-builds-binaries/releases/download/12.2.0-rt_v10-rev0/x86_64-

12.2.0-release-win32-seh-rt_v10-rev0.7z

• LLVM installer (gcc/g++)

• Download LLVM releases13

– Also use the following notes
∗ https://llvm.org/devmtg/2014-04/PDFs/Talks/clang-cl.pdf

12https://sourceforge.net/projects/mingw-w64/files/Toolchains%20targetting%20Win32/Personal%20Builds/mingw-
builds/installer/mingw-w64-install.exe/download

13https://releases.llvm.org/
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0.2.5.4 GCC/G++ Complier (MinGW) / Clang-cl (LLVM) (2) Open a console with “cmd” and
test the following commands if commands are not recognized then set the system environment variable to
add gcc and g++ executable paths to the path variable (add to both system and user path variable)

gcc --version

g++ --version

C:\Users\ugur.coruh>gcc --version
gcc (x86_64-win32-seh-rev0, Built by MinGW-W64 project) 8.1.0
Copyright (C) 2018 Free Software Foundation, Inc.
This is free software; see the source for copying conditions. There is NO
warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

clang --version

0.2.5.5 GCC/G++ Complier (MinGW) / Clang-cl (LLVM) (3)

• for gcc.exe, g++.exe and gdb.exe

C:\Program Files\mingw-w64\x86_64-8.1.0-win32-seh-rt_v6-rev0\mingw64\bin

• for clang.exe, lldb.exe

C:\Program Files\LLVM\bin

This folder path changes according to your setup

0.2.6 VSCode (Install / Compile / Run / Debug) (1)

Download Visual Studio Code from the following link

Download Visual Studio Code - Mac, Linux, Windows14

0.2.6.1 VSCode (Install / Compile / Run / Debug) (2) In this sample, you will find MinGW and
LLVM compiler combinations for C and C++

Create a folder and enter this folder then open this folder with vscode by right click
14https://code.visualstudio.com/download
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0.2.6.2 VSCode (Install / Compile / Run / Debug) (3) or enter the folder via console

write

code .

0.2.6.3 VSCode (Install / Compile / Run / Debug) (4)

• This will open vscode for the current folder, (.) dot present current folder.
• You will see an empty folder in the right window
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0.2.6.4 VSCode (Install / Compile / Run / Debug) (5)

0.2.6.5 VSCode (Install / Compile / Run / Debug) (6)

• Create a hello.c file and write the following content

#include <stdio.h>
int main() {

// printf() displays the string inside quotation
printf("Hello, World!");
return 0;

}

0.2.6.6 VSCode (Install / Compile / Run / Debug) (7) use CTRL+SHIFT+B (you should be on the
source code section) to build a file
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0.2.6.7 VSCode (Install / Compile / Run / Debug) (8) Select GCCor CLANGfor this sample we can
use GCC

You will see the output generated ‘Hello.exe“

0.2.6.8 VSCode (Install / Compile / Run / Debug) (9) for debugging just put a breakpoint and
build again

0.2.6.9 VSCode (Install / Compile / Run / Debug) (10)

• after building for debug press CTRL+SHIFT+D (you should be in the source code section)and in the right
window select create launch.json
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0.2.6.10 VSCode (Install / Compile / Run / Debug) (11)

• from opening, window select C++ GDB/LLDB

0.2.6.11 VSCode (Install / Compile / Run / Debug) (12)

• from the next opening, menu select mingw-w64 gcc.exe
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0.2.6.12 VSCode (Install / Compile / Run / Debug) (13) this will run the debugger and you will
see debug points activated

0.2.6.13 VSCode (Install / Compile / Run / Debug) (14) then you can step-by-step debug your
code.

the following task.json and launch.json automatically generated with your selections

0.2.6.14 VSCode (Install / Compile / Run / Debug) (15) launch.json

{
// Olası öznitelikler hakkında bilgi edinmek için IntelliSense kullanın.
// Mevcut özniteliklerin açıklamalarını görüntülemek için üzerine gelin.
// Daha fazla bilgi için şu adresi ziyaret edin: https://go.microsoft.com/fwlink/?linkid=830387
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"version": "0.2.0",
"configurations": [
{

"name": "gcc.exe - Etkin dosyayı derle ve dosyada hata ayıkla",
"type": "cppdbg",
"request": "launch",
"program": "${fileDirname}\\${fileBasenameNoExtension}.exe",
"args": [],
"stopAtEntry": false,
"cwd": "${fileDirname}",
"environment": [],
"externalConsole": false,
"MIMode": "gdb",
"miDebuggerPath": "C:\\Program Files\\mingw-w64\\x86_64-8.1.0-win32-seh-rt_v6-rev0\\mingw64\\bin\\gdb.exe",
"setupCommands": [
{
"description": "gdb için düzgün yazdırmayı etkinleştir",
"text": "-enable-pretty-printing",
"ignoreFailures": true

}
],
"preLaunchTask": "C/C++: gcc.exe etkin dosyayı derle"

}
]

}

0.2.6.15 VSCode (Install / Compile / Run / Debug) (16) task.json

{
"tasks": [
{

"type": "cppbuild",
"label": "C/C++: gcc.exe etkin dosyayı derle",
"command": "C:\\Program Files\\mingw-w64\\x86_64-8.1.0-win32-seh-rt_v6-rev0\\mingw64\\bin\\gcc.exe",
"args": [
"-fdiagnostics-color=always",
"-g",
"${file}",
"-o",
"${fileDirname}\\${fileBasenameNoExtension}.exe"

],
"options": {
"cwd": "${fileDirname}"

},
"problemMatcher": ["$gcc"],
"group": {
"kind": "build",
"isDefault": true

},
"detail": "Hata Ayıklayıcısı tarafından oluşturulan görev."

}
],
"version": "2.0.0"

}
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0.2.6.16 VSCode (Install / Compile / Run / Debug) (17)

• You can do the same thing for other compilers and C++ source codes. LLVM does not support
debugging on vscode now.

for C++ VsCode you can check the following links

• for Windows

– https://code.visualstudio.com/docs/cpp/config-mingw

• for Linux

– https://code.visualstudio.com/docs/cpp/config-linux

• for WSL

– https://code.visualstudio.com/docs/cpp/config-wsl

0.2.6.17 VSCode (Install / Compile / Run / Debug) (18) in the launch file if you start debugging
with F5

(you can select debugger with CTRL+SHIFT+P and then write Debug and Selecting Configure Debugger Option)

0.2.6.18 VSCode (Install / Compile / Run / Debug) (19)

• the following line will be your debugging application path

• if you start debugging with F5in Hello.c file this will set <Hello.c base path>/Hello.exe

0.2.6.19 VSCode (Install / Compile / Run / Debug) (20) You should set this correct for both
LLVMand GCC configuration in launch.json

"program": "${fileDirname}\\${fileBasenameNoExtension}.exe",

Also you should set your installed debugger paths

for GCC

"miDebuggerPath": "C:\\Program Files\\mingw-w64\\x86_64-8.1.0-win32-seh-rt_v6-rev0\\mingw64\\bin\\gdb.exe",

for LLVM

"miDebuggerPath": "C:\\Program Files\\LLVM\\bin\\lldb.exe",

for more details please check the sample source codes.

0.2.7 Visual Studio Code Extension List (1)

My Extension List

• Listing Installed Extensions

PS C:\Users\ugur.coruh\Desktop> code --list-extensions | % { "code --install-extension $_" }

Following topic can help you

How can you export the Visual Studio Code extension list? - Stack Overflow15

15https://stackoverflow.com/questions/35773299/how-can-you-export-the-visual-studio-code-extension-list
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0.2.8 Visual Studio Code Extension List (2)

code --install-extension 2gua.rainbow-brackets
code --install-extension aaron-bond.better-comments
code --install-extension abusaidm.html-snippets
code --install-extension ACharLuk.easy-cpp-projects
code --install-extension chris-noring.node-snippets
code --install-extension cschlosser.doxdocgen
code --install-extension csholmq.excel-to-markdown-table
code --install-extension DaChuiOpenSource.FreeMind
code --install-extension dannysteenman.cloudformation-yaml-snippets
code --install-extension Dart-Code.dart-code
code --install-extension Dart-Code.flutter
code --install-extension digized.umple
code --install-extension DotJoshJohnson.xml
code --install-extension DougFinke.vscode-pandoc
code --install-extension dzhavat.bracket-pair-toggler
code --install-extension esbenp.prettier-vscode
code --install-extension formulahendry.dotnet
code --install-extension franneck94.c-cpp-runner
code --install-extension gcc.

0.2.9 Visual Studio Code Extension List (3)

vscode-plugin-billionbottle
code --install-extension geeklearningio.graphviz-markdown-preview
code --install-extension geyao.html-snippets
code --install-extension GitHub.copilot-nightly
code --install-extension GrapeCity.gc-excelviewer
code --install-extension Ionide.Ionide-fsharp
code --install-extension ionut-botizan.vscode-cypher-ql
code --install-extension ipedrazas.kubernetes-snippets
code --install-extension JakeWilson.vscode-picture
code --install-extension James-Yu.latex-workshop
code --install-extension JasonMejane.base64viewer
code --install-extension jasonnutter.search-node-modules
code --install-extension jebbs.plantuml
code --install-extension jeff-hykin.better-cpp-syntax
code --install-extension Katacoda.vscode
code --install-extension KenDomino.Antlrvsix-vscode
code --install-extension l7ssha.tag-inserter
code --install-extension lolkush.quickstart
code --install-extension marp-team.marp-vscode
code --install-extension mindaro-dev.file-downloader
code --install-extension mindaro.mindaro
code --install-extension ms-azuretools.vscode-docker
code --install-extension MS-CEINTL.vscode-language-pack-tr

0.2.10 Visual Studio Code Extension List (4)

code --install-extension ms-dotnettools.csharp
code --install-extension ms-dotnettools.dotnet-interactive-vscode
code --install-extension ms-dotnettools.vscode-dotnet-pack
code --install-extension ms-dotnettools.vscode-dotnet-runtime
code --install-extension ms-kubernetes-tools.vscode-aks-tools

36



code --install-extension ms-kubernetes-tools.vscode-kubernetes-tools
code --install-extension ms-python.python
code --install-extension ms-python.vscode-pylance
code --install-extension ms-toolsai.jupyter
code --install-extension ms-toolsai.jupyter-keymap
code --install-extension ms-toolsai.jupyter-renderers
code --install-extension ms-vscode-remote.remote-containers
code --install-extension ms-vscode-remote.remote-ssh
code --install-extension ms-vscode-remote.remote-ssh-edit
code --install-extension ms-vscode-remote.remote-wsl

0.2.11 Visual Studio Code Extension List (5)

code --install-extension ms-vscode.azure-account
code --install-extension ms-vscode.brackets-keybindings
code --install-extension ms-vscode.brackets-pack
code --install-extension ms-vscode.cmake-tools
code --install-extension ms-vscode.cpptools
code --install-extension ms-vscode.cpptools-extension-pack
code --install-extension ms-vscode.cpptools-themes
code --install-extension ms-vscode.live-server
code --install-extension ms-vsliveshare.vsliveshare
code --install-extension oleg-shilo.cs-script
code --install-extension PascalReitermann93.vscode-yaml-sort

0.2.12 Visual Studio Code Extension List (6)

code --install-extension Pivotal.vscode-boot-dev-pack
code --install-extension Pivotal.vscode-concourse
code --install-extension Pivotal.vscode-manifest-yaml
code --install-extension Pivotal.vscode-spring-boot
code --install-extension PKief.material-icon-theme
code --install-extension platformio.platformio-ide
code --install-extension pranaygp.vscode-css-peek
code --install-extension redhat.fabric8-analytics
code --install-extension redhat.java
code --install-extension redhat.vscode-commons
code --install-extension redhat.vscode-xml
code --install-extension redhat.vscode-yaml
code --install-extension ritwickdey.LiveServer
code --install-extension sidthesloth.html5-boilerplate
code --install-extension TaodongWu.ejs-snippets
code --install-extension tht13.python
code --install-extension tomoki1207.pdf
code --install-extension twxs.cmake
code --install-extension vadimcn.vscode-lldb

0.2.13 Visual Studio Code Extension List (7)

code --install-extension VisualStudioExptTeam.intellicode-api-usage-examples
code --install-extension VisualStudioExptTeam.vscodeintellicode
code --install-extension vscjava.vscode-java-debug
code --install-extension vscjava.vscode-java-dependency

37



code --install-extension vscjava.vscode-java-pack
code --install-extension vscjava.vscode-java-test
code --install-extension vscjava.vscode-maven
code --install-extension vscjava.vscode-spring-boot-dashboard
code --install-extension vscjava.vscode-spring-initializr
code --install-extension walkme.HTML5-extension-pack
code --install-extension webfreak.debug
code --install-extension well-ar.plantuml
code --install-extension wildboar.asn1
code --install-extension Zignd.html-css-class-completion

0.2.14 Visual Studio Community Edition (Install / Compile / Run / Debug) (1)

• Download and install Visual Studio Community Edition
• Select All Development Environments from Installer.

Ücretsiz Geliştirici Yazılımları ve Hizmetleri - Visual Studio16

0.2.15 Visual Studio Community Edition (Install / Compile / Run / Debug) (2)

• After installation open Visual Studio2022‘ from the menu.

16https://visualstudio.microsoft.com/tr/free-developer-offers/
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0.2.16 Visual Studio Community Edition (Install / Compile / Run / Debug) (3)

• The application will start…

0.2.17 Visual Studio Community Edition (Install / Compile / Run / Debug) (4)

• From Opening Window Select Create a new project
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0.2.18 Visual Studio Community Edition (Install / Compile / Run / Debug) (5)

• There will be several options, you can review them.

• Select Windows, C++, Console Application from Combobox.

• Select Console Application

0.2.19 Visual Studio Community Edition (Install / Compile / Run / Debug) (6)

• Give a solution and project name.
• Select save location
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0.2.20 Visual Studio Community Edition (Install / Compile / Run / Debug) (7)

• You will have C++ basic Hello World application.
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0.2.21 Visual Studio Community Edition (Install / Compile / Run / Debug) (8)

• You will have C++ basic Hello World application.

// ConsoleApplication1.cpp : This file contains the 'main' function. Program execution begins and ends there.
//

#include <iostream>

int main()
{

std::cout << "Hello World!\n";
}

// Run program: Ctrl + F5 or Debug > Start Without Debugging menu
// Debug program: F5 or Debug > Start Debugging menu

// Tips for Getting Started:
// 1. Use the Solution Explorer window to add/manage files
// 2. Use the Team Explorer window to connect to source control
// 3. Use the Output window to see build output and other messages
// 4. Use the Error List window to view errors
// 5. Go to Project > Add New Item to create new code files, or Project > Add Existing Item to add existing code files to the project
// 6. In the future, to open this project again, go to File > Open > Project and select the .sln file
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0.2.22 Visual Studio Community Edition (Install / Compile / Run / Debug) (9)

• We need to rename the file extension to c from cpp

0.2.23 Visual Studio Community Edition (Install / Compile / Run / Debug) (10)

• If you compile the source C compiler will be used.
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0.2.24 Visual Studio Community Edition (Install / Compile / Run / Debug) (11)

• We need to update our source for C as follows

// ConsoleApplication1.c : This file contains the 'main' function. Program execution begins and ends there.
//

#include <stdio.h>

int main(){
printf("Hello World!\n");

}

0.2.25 Visual Studio Community Edition (Install / Compile / Run / Debug) (12)

• We need to update our source for C as follows

0.2.26 Visual Studio Community Edition (Install / Compile / Run / Debug) (13)

• Put a breakpoint by clicking the following location. Breakpoints will be stop points for our debugging
operations.
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0.2.27 Visual Studio Community Edition (Install / Compile / Run / Debug) (14)

• Then select Debug configuration and according to your operating system select x64 or x86 configuration
and click Local Windows Debugger

0.2.28 Visual Studio Community Edition (Install / Compile / Run / Debug) (15)

• Update your source code as follow

// ConsoleApplication1.c : This file contains the 'main' function. Program execution begins and ends there.
//

#include <stdio.h>

int sum(int input1, int input2);

int main(){
int number = 5;
printf("Before Increment : %d\n",number);
number = sum(number, 5);
printf("After Increment : %d\n", number);

}

int sum(int input1, int input2){
return input1 + input2;

}
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0.2.29 Visual Studio Community Edition (Install / Compile / Run / Debug) (16)

• Put the following breakpoints and run the debugger. On number, the variable pins the variable to see
its value in real-time.

0.2.30 Visual Studio Community Edition (Install / Compile / Run / Debug) (17)

• Open Debug->Windows->Memory->Memory1 to see value in memory
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0.2.31 Visual Studio Community Edition (Install / Compile / Run / Debug) (18)

• In the memory window copy variable name (number) with address operator (&) and then (&number)
press enter.
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0.2.32 Visual Studio Community Edition (Install / Compile / Run / Debug) (19)

• You can see its value in memory with hexadecimal form (05 00 00 00)
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0.2.33 Visual Studio Community Edition (Install / Compile / Run / Debug) (20)

• If you change value with pinned control your memory value and your current value will be updated.
20 in hexadecimal 0x14 (integer is 4 bytes length for this reason memory shows 14 00 00 00)
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0.2.34 Visual Studio Community Edition (Install / Compile / Run / Debug) (21)

• If you close some windows such as solution explorer, and properties windows you can open them from
the View menu.
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0.2.35 Visual Studio Community Edition (Install / Compile / Run / Debug) (22)

• Solution and Projects have several configurations for each setup such as Release - x86, Release-x64,
Debug- x86, and Debug-x64 you need to configure all of them for your requirements. You can access
configurations by right-clicking to project and then selecting properties.
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0.2.36 Visual Studio Community Edition (Install / Compile / Run / Debug) (23)

• Project properties has several settings
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0.2.36.1 Notepad++ (Install / Compile ) (1)

• Please download Notepad++ from the following link
– Downloads | Notepad++17

0.2.36.2 Notepad++ (Install / Compile ) (2) Download and install MinGW or LLVM compiler (if
you downloded then skip this step)

MinGW installer (gcc / g++)

• A complete runtime environment for gcc
– https://sourceforge.net/projects/mingw-w64/
– https://sourceforge.net/projects/mingw-w64/files/latest/download

• w64devkit is a portable C and C++ development kit for x64 (and x86) Windows.
– https://www.mingw-w64.org/downloads/#w64devkit

• Also, see the following notes
– https://www.hanshq.net/building-gcc.html

0.2.36.3 Notepad++ (Install / Compile ) (3) LLVM installer (clang)

• Download
17https://notepad-plus-plus.org/downloads/
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– https://releases.llvm.org/
• Also, use the following notes

– https://llvm.org/devmtg/2014-04/PDFs/Talks/clang-cl.pdf
– https://www.hanshq.net/clang-plugin-example.html

0.2.36.4 Notepad++ (Install / Compile ) (4) Open a console with “cmd” and test the following
commands if commands are not recognized then set the system environment variable to add gcc and g++
executable paths to the path variable (add to both system and user path variable)

gcc --version

g++ --version

C:\Users\ugur.coruh>gcc --version
gcc (x86_64-win32-seh-rev0, Built by MinGW-W64 project) 8.1.0
Copyright (C) 2018 Free Software Foundation, Inc.
This is free software; see the source for copying conditions. There is NO
warranty; not even for MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

0.2.36.5 Notepad++ (Install / Compile ) (5)

• Open system environments to update path variable for gcc/g++ and clang
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0.2.36.6 Notepad++ (Install / Compile ) (6)

• Open “Environment Variables”
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0.2.36.7 Notepad++ (Install / Compile ) (7)

• Select path variable from user section.
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0.2.36.8 Notepad++ (Install / Compile ) (8)

• Select path variable from system section.

0.2.36.9 Notepad++ (Install / Compile ) (9)

• Update variables add MinGW and LLVM to path gcc.exe g++.exe clang.exe will be in bin folders. Then
we can run this commands from command line.

0.2.36.10 Notepad++ (Install / Compile ) (9)

• Update variables add MinGW and LLVM to path gcc.exe g++.exe clang.exe will be in bin folders. Then
we can run this commands from command line.
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0.2.36.11 Notepad++ (Install / Compile ) (10)

• for gcc.exe, g++.exe and gdb.exe

C:\Program Files\mingw-w64\x86_64-8.1.0-win32-seh-rt_v6-rev0\mingw64\bin

0.2.36.12 Notepad++ (Install / Compile ) (11)

• for clang.exe , lldb.exe we will use the following path

C:\Program Files\LLVM\bin

0.2.36.13 Notepad++ (Install / Compile ) (12)

• This folder paths changes according to your setup

• Open NppExec extension (install from extension manager if not exist)
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0.2.36.14 Notepad++ (Install / Compile ) (13)

• Write the following commands in the box

NPP_SAVE // save current file
cd $(CURRENT_DIRECTORY) // go to directory of the current file
gcc -Wall -Wextra -Wpedantic -std=c++11 -o "$(NAME_PART)" "$(FILE_NAME)"

0.2.36.15 Notepad++ (Install / Compile ) (14)

• Save the script as gcc-build and for more information check the following link

• You can modify or add multiple scripts for another task.

0.2.37 MSYS2

• Software Distribution and Building Platform for Windows

https://www.msys2.org/

0.2.37.1 Vi/Vim (C/C++) for Windows (1)

• Vim is a command-line editor for programming
• Use the following links to download Vim for Windows

– https://github.com/vim/vim-win32-installer/releases
– download : vim online18

18https://www.vim.org/download.php
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0.2.37.2 Vi/Vim (C/C++) for Windows (2)

• Run setup to install the application on your computer.

0.2.37.3 Vi/Vim (C/C++) for Windows (3)

0.2.37.4 Vi/Vim (C/C++) for Windows (4)

• Installation steps.
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0.2.37.5 Vi/Vim (C/C++) for Windows (5)

• Installation steps.
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0.2.37.6 Vi/Vim (C/C++) for Windows (6)

• Installation steps.
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0.2.37.7 Vi/Vim (C/C++) for Windows (7)

• Installation steps.
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0.2.37.8 Vi/Vim (C/C++) for Windows (8)

• Installation steps.
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0.2.37.9 Vi/Vim (C/C++) for Windows (9)

• Installation steps.

67



0.2.37.10 Vi/Vim (C/C++) for Windows (10)

• Generated shortcuts on your desktop
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0.2.37.11 Vi/Vim (C/C++) for Windows (11)

• Run vim hello.c on your command-line to open a c file with vim editor.
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0.2.37.12 Vi/Vim (C/C++) for Windows (12)

• You will have the following editor.
• Use INSERT to change edit options.
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0.2.37.13 Vi/Vim (C/C++) for Windows (13)

• Sample source code

#include <stdio.h>
int main()
{

char name[20];
printf("Enter Name:");
scanf("%s",name);
printf("Your name is %s",name);
return 0;

}

0.2.37.14 Vi/Vim (C/C++) for Windows (14)

• Write source code
• Press the Esc button to enter command mode
• Then type :wq. It will save the file and exit from Vim

– w: write
– q: quit
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0.2.37.15 Vi/Vim (C/C++) for Windows (15)

• compile source code with gcc
• link the objects and
• run executable

0.2.37.16 Vi/Vim (C/C++) for Windows (17)

• In the folder, you can find your executable. hello.exe
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0.2.37.17 Vi/Vim (C/C++) for Windows (16)

• compile, link and execute flow will be as follow;
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0.2.37.18 Eclipse (C/C++) - Compile Only / Debugging Has Problem (1)

74



• Download and install Eclipse IDE from the following link
– Eclipse IDE for C/C++ Developers | Eclipse Packages19

• Run Installer
• Select Eclipse IDE for C/C++ Developers

0.2.37.19 Eclipse (C/C++) - Compile Only / Debugging Has Problem (2)

• Select Java Version and Installation Path
19https://www.eclipse.org/downloads/packages/release/kepler/sr2/eclipse-ide-cc-developers
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0.2.37.20 Eclipse (C/C++) - Compile Only / Debugging Has Problem (3)

• After installation you can LAUNCH eclipse IDE
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0.2.37.21 Eclipse (C/C++) - Compile Only / Debugging Has Problem (4)

0.2.37.22 Eclipse (C/C++) - Compile Only / Debugging Has Problem (5)

• Select a workspace that your project will be saved

0.2.37.23 Eclipse (C/C++) - Compile Only / Debugging Has Problem (6)

• You can find your installation under your user folder
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0.2.37.24 Eclipse (C/C++) - Compile Only / Debugging Has Problem (7)

• You can create shortcut to desktop for your working eclipse version.

0.2.37.25 Eclipse (C/C++) - Compile Only / Debugging Has Problem (8)

• File -> New -> Project
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0.2.37.26 Eclipse (C/C++) - Compile Only / Debugging Has Problem (9)

• Select C/C++ Project
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0.2.37.27 Eclipse (C/C++) - Compile Only / Debugging Has Problem (10)

• Select C Managed Build, Eclipse CDT will do job for us.
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0.2.37.28 Eclipse (C/C++) - Compile Only / Debugging Has Problem (11)

• Give project name and select a basic template executable with MinGW GCC.
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0.2.37.29 Eclipse (C/C++) - Compile Only / Debugging Has Problem (12)

• Configura Basic Settings

83



0.2.37.30 Eclipse (C/C++) - Compile Only / Debugging Has Problem (13)

• There are default Debug and Release configurations you can add your customized configurations from
Advanced Settings.

84



0.2.37.31 Eclipse (C/C++) - Compile Only / Debugging Has Problem (14)

• Project settings will be C Select Debug/Release configuration and then Build Application Project-
>Build All (Ctrl+B)

• HelloWorldC.exe will be generated

gcc -O0 -g3 -Wall -c -fmessage-length=0 -o "src\\HelloWorldC.o" "..\\src\\HelloWorldC.c"

85



gcc -o HelloWorldC.exe "src\\HelloWorldC.o"

0.2.37.32 Eclipse (C/C++) - Compile Only / Debugging Has Problem (15)

• Before build if you want to debug application select debug configuration, put your breakpoints and
then Build application again.

• Right click the generated executable Debug As -> Local C/C++ Application
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0.2.37.33 Eclipse (C/C++) - Compile Only / Debugging Has Problem (16)

• Debugger will start and stop at breakpoint as follow.
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0.2.37.34 Eclipse (C/C++) - Compile Only / Debugging Has Problem (16)

• Check debug control shortcuts and use them

0.2.37.35 Eclipse (C/C++) - Compile Only / Debugging Has Problem (17)

• To watch variables use Expressions and Variables
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0.2.37.36 Eclipse (C/C++) - Compile Only / Debugging Has Problem (18)

0.2.37.37 Eclipse (C/C++) - Compile Only / Debugging Has Problem (19)

• for more visit eclipse webpage

– Effective Techniques for Debugging C & C++ | The Eclipse Foundation20

– Help - Eclipse IDE21

0.2.37.38 Eclipse (C/C++) - Compile Only / Debugging Has Problem (20)

• Generate CMAKE project from new Project and Select CMake Project Template
20https://www.eclipse.org/community/eclipse_newsletter/2017/april/article2.php
21https://rtist.hcldoc.com/help/index.jsp?topic=%2Forg.eclipse.cdt.doc.user%2Fgetting_started%2Fcdt_w_debug.htm
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0.2.37.39 Eclipse (C/C++) - Compile Only / Debugging Has Problem (21)

• Give project name
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0.2.37.40 Eclipse (C/C++) - Compile Only / Debugging Has Problem (22)

• This will generate default C++ Hello World project
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0.2.37.41 Eclipse (C/C++) - Compile Only / Debugging Has Problem (23)

• Build Project

0.2.37.42 Eclipse (C/C++) - Compile Only / Debugging Has Problem (24)

• It will give following errors, for missing configurations. This errors are generated by CMAKE

• Then clean and rebuild again.

Errors occurred during the build.
Errors running builder 'CDT Core Builder' on project 'HelloWorldCmakeC'.
Resource '/HelloWorldCmakeC/build/cmake.debug.win32.x86_64/compile_commands.json' does not exist.
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Resource '/HelloWorldCmakeC/build/cmake.debug.win32.x86_64/compile_commands.json' does not exist.
Resource '/HelloWorldCmakeC/build/cmake.debug.win32.x86_64/compile_commands.json' does not exist.
Resource '/HelloWorldCmakeC/build/cmake.debug.win32.x86_64/compile_commands.json' does not exist.

0.2.37.43 Eclipse (C/C++) - Compile Only / Debugging Has Problem (25)

0.2.37.44 Eclipse (C/C++) - Compile Only / Debugging Has Problem (26)

• After this operation first Clean project from Project menu and then Build All again

94



0.2.37.45 Eclipse (C/C++) - Compile Only / Debugging Has Problem (27)

• Eclipse with CMake project on windows22

• JV - Science and stuff.23

22https://yairgadelov.me/eclipse-with-cmake-project-on-windows/
23https://jvgomez.github.io/pages/how-to-configure-a-cc-project-with-eclipse-and-cmake.html
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0.2.37.46 Eclipse (C/C++) - Compile Only / Debugging Has Problem (28)
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0.2.37.47 Eclipse (C/C++) - Compile Only / Debugging Has Problem (29)

0.2.37.48 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-
tion for C/C++ Development (1)

• https://netbeans.apache.org/

• C and C++ Tutorials24

24https://netbeans.apache.org/kb/docs/cnd/
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0.2.37.49 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++Development (2)
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0.2.37.50 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++Development (3)

0.2.37.51 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++ Development (4)
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0.2.37.52 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++Development (5)

0.2.37.53 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++Development (6)
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0.2.37.54 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++Development (7)
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0.2.37.55 Netbeans (C/C++) - Manuel Build/Clean/Run Command Setting Not Good Op-

tion for C/C++Development (8)

0.2.37.56 Turbo C/C++ (1) Download Turbo.C.3.2.zip25

• Download Turbo C++ for Windows 7, 8, 8.1, 10 and Windows 11 (32-64 bit) with full/window screen
mode and many more extra features26

• Turbo C++ Shortcuts - C Programming Language Tutorials27

25files/Turbo.C.3.2.zip
26https://developerinsider.co/download-turbo-c-for-windows-7-8-8-1-and-windows-10-32-64-bit-full-screen/
27https://developerinsider.co/turbo-c-shortcuts/
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0.2.37.57 Turbo C/C++ (2)

0.2.37.58 Cmake (C++/C) (1) CMake (http://www.cmake.org/) is a program which generates the
Makefiles used by Make.

103



0.2.37.59 Cmake (C++/C) (2) Why use CMake ?

• Eases Make use
– but the same way of thinking
– generate the Makefile

• Separate the compilation from the sources
• Multi-platfoms
• Very flexible

0.2.37.60 Cmake (C++/C) (3)

• Check if the libraries/programs are available on your system
• File generator (configure_file)
• Calling programs or scripts (doxygen)
• One of the new standards

0.2.37.61 Cmake (C++/C) (4) (Download and Install) use the following link for download

Download | CMake28

0.2.37.62 Cmake (C++/C) (5) (WSL and Linux Environment) Hello world with CMake29

0.2.37.63 Cmake (C++/C) (6) (Windows Environment) main.c

#include <stdio.h>
int main()
{

char name[20];
printf("Enter name: ");
scanf("%s", name);
printf("Your name is %s.", name);
return 0;

}

CMakeLists.txt

cmake_minimum_required(VERSION 3.7.2)
project(scanf-sample)
add_executable(scanf-sample main.c)

0.2.37.64 Cmake (C++/C) (7) (Windows Environment) put main.c and CMakeLists.txt file in
sample-scanf folder and from command line

28https://cmake.org/download/
29https://lappweb.in2p3.fr/~paubert/ASTERICS_HPC/2-2-100.html

104

https://cmake.org/download/
https://lappweb.in2p3.fr/~paubert/ASTERICS_HPC/2-2-100.html


run the following cmake command with dot (.) to create solution file for c project

C:\Users\ugur.coruh\Desktop\sample-scanf>cmake .

0.2.37.65 Cmake (C++/C) (8) (Windows Environment) I have Visual Studio 2022 Community
Edition Installed on My Computer, for these reason build tools are selected for visual studio environment
and the following outputs are generated

C:\Users\ugur.coruh\Desktop\sample-scanf>cmake .
-- Building for: Visual Studio 17 2022
-- Selecting Windows SDK version 10.0.22000.0 to target Windows 10.0.19043.
-- The C compiler identification is MSVC 19.30.30704.0
-- The CXX compiler identification is MSVC 19.30.30704.0
-- Detecting C compiler ABI info
-- Detecting C compiler ABI info - done
-- Check for working C compiler: C:/Program Files/Microsoft Visual Studio/2022/Community/VC/Tools/MSVC/14.30.30704/bin/Hostx64/x64/cl.exe - skipped
-- Detecting C compile features
-- Detecting C compile features - done
-- Detecting CXX compiler ABI info
-- Detecting CXX compiler ABI info - done
-- Check for working CXX compiler: C:/Program Files/Microsoft Visual Studio/2022/Community/VC/Tools/MSVC/14.30.30704/bin/Hostx64/x64/cl.exe - skipped
-- Detecting CXX compile features
-- Detecting CXX compile features - done
-- Configuring done
-- Generating done
-- Build files have been written to: C:/Users/ugur.coruh/Desktop/sample-scanf

C:\Users\ugur.coruh\Desktop\sample-scanf>

0.2.37.66 Cmake (C++/C) (9) (Windows Environment) also following files are generated

105



0.2.37.67 Cmake (C++/C) (10) (Windows Environment) if we open scanf-sample.sln file we will
have automated generated project files

0.2.37.68 Cmake (C++/C) (11) (Windows Environment) you can make scanf-sample with startup
project with right click and then run on visual studio.

if you want to configure for another build tool you can use Cmake-GUI installed with setup on your computer
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0.2.37.69 Cmake (C++/C) (12) (Windows Environment) Open GUI and Select File-> Delete
Cache

107



0.2.37.70 Cmake (C++/C) (13) (Windows Environment) then you can click “Configure” to select
build tool
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0.2.37.71 Cmake (C++/C) (14) (Windows Environment)

0.2.37.72 Cmake (C++/C) (15) (Windows Environment) if you click “Configure” twice it will
generate the visual studio solution in build folder

for more detailed examples that include also docker and travis-ci sample you can check the following repo

GitHub - ttroy50/cmake-examples: Useful CMake Examples30

0.2.37.73 Make (1) Sample

hello.c

#include <stdio.h>

int main(void)
{

printf("hello, world\n");
}

0.2.37.74 Make (2) Makefile

# This is the default target, which will be built when
# you invoke make

30https://github.com/ttroy50/cmake-examples
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.PHONY: all
all: hello

# This rule tells make how to build hello from hello.cpp
hello: hello.c

g++ -o hello hello.c

# This rule tells make to copy hello to the binaries subdirectory,
# creating it if necessary
.PHONY: install
install:

mkdir -p binaries
cp -p hello binaries

# This rule tells make to delete hello and hello.o
.PHONY: clean
clean:

rm -f hello

0.2.37.75 Make (3) compile.bat

make all .

will create hello.exe

check hello-make sample

0.2.37.76 Make (4)
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1 JAVA Environment and Development
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1.0.1 JDK and JRE Setup (1)

1.0.2 JDK and JRE Setup (2)

• JDK (Java Development Kit) is a Kit that provides the environment to develop and exe-
cute(run) the Java program. JDK is a kit(or package) that includes two things

– Development Tools(to provide an environment to develop your java programs)
– JRE (to execute your java program).

• JRE (Java Runtime Environment) is an installation package that provides an environment to only
run(not develop) the java program(or application)onto your machine. JRE is only used by those
who only want to run Java programs that are end-users of your system.

• JVM (Java Virtual Machine)31 is a very important part of both JDK and JRE because it is con-
tained or inbuilt in both. Whatever Java program you run using JRE or JDK goes into JVM and JVM is
responsible for executing the java program line by line, hence it is also known as an i***nterpreter***32.

• Difference between JDK, JRE, JVM - TutorialAndExample33

31https://www.geeksforgeeks.org/jvm-works-jvm-architecture/
32https://www.geeksforgeeks.org/compiler-vs-interpreter-2/
33https://www.tutorialandexample.com/difference-between-jdk-jre-jvm
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1.0.3 System Environments and Paths for Java (1)

1.0.4 System Environments and Paths for Java (2)

• Select path variable (JDK should be set there)

115



1.0.5 System Environments and Paths for Java (3)

• JAVA_HOME also should be set

1.0.6 Netbeans (Java) (1)

• Open New Project -> Java Project
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1.0.7 Netbeans (Java) (2)
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1.0.8 Netbeans (Java) (3)
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1.0.9 Netbeans (Java) (4)

1.0.10 Netbeans (Java) (5)
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1.0.11 Netbeans (Java) (6)

Update code and run

/*
* Click nbfs://nbhost/SystemFileSystem/Templates/Licenses/license-default.txt to change this license
* Click nbfs://nbhost/SystemFileSystem/Templates/Classes/Class.java to edit this template
*/

package com.ucoruh.mavenproject1;

/**
*
* @author ugur.coruh
*/

public class NewClass {

static //static block
{

System.out.println("Static block");
}

public static void main(String args[]) //static method
{

System.out.println("Static method");
}

}
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1.0.12 Netbeans (Java) (7)

1.0.13 Netbeans (Java) (8)
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1.0.14 Netbeans (Java) (9)

1.0.15 Netbeans (Java) (10)

1.0.16 Eclipse (Java) (1)

• Select File -> New Project
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1.0.17 Eclipse (Java) (2)
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1.0.18 Eclipse (Java) (3)
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1.0.19 Eclipse (Java) (4)
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1.0.20 Eclipse (Java) (5)

1.0.21 Eclipse (Java) (6)

• Update source

package ucoruh;

public class HelloClass {
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static {
System.out.println("Static Block");

}

public static void main(String[] args) {
// TODO Auto-generated method stub
System.out.println("Static Method");

}

}

1.0.22 Eclipse (Java) (7)
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1.0.23 Eclipse (Java) (8)

1.0.24 Intellij Idea (Jet Brains) (Java)

• Download IntelliJ IDEA: The Capable & Ergonomic Java IDE by JetBrains34

– Select Community Version or Student Ultimate Version
34https://www.jetbrains.com/idea/download/#section=windows
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1.0.25 VSCode (Java)

• Java Extension Run&Debug Java Files
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1.0.26 Notepad++ (Java)

• How to Compile and Run Java Programs Using Notepad++35

1.0.27 Cmake (Java)

• UseJava — CMake 3.24.2 Documentation36

• GitHub - ptitpoulpe/cmake-swig-java-example: An example of combining cmake, swig and java37

2 C# Environment and Development

2.0.1 Visual Studio Community Edition (C#)

//TODO//
35https://www.wikihow.com/Compile-and-Run-Java-Program-by-Notepad
36https://cmake.org/cmake/help/latest/module/UseJava.html
37https://github.com/ptitpoulpe/cmake-swig-java-example
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2.0.2 Notepad++ (C#)

• This use command-line utilities for csharp, nppexec should be configured for this utility.

• Compiling/Executing a C# Source File in Command Prompt - Stack Overflow38

c:\windows\Microsoft.NET\Framework\v3.5\

c:\windows\Microsoft.NET\Framework\v3.5\bin\csc.exe
/t:exe /out:MyApplication.exe MyApplication.cs ...

2.0.3 Cmake (C#)

• GitHub - crud89/DotNetWithCMake: Your swiss army knife for creating .NET assemblies with CMake
and integrating unmanaged code.39

2.0.4 Common Tools and Platforms

2.0.5 Fatih Kalem

https://cdnvideo.eba.gov.tr/fatihkalem/fatihkalem_portable.zip

https://cdnvideo.eba.gov.tr/fatihkalem/fatihkalem_setup.exe
38https://stackoverflow.com/questions/553143/compiling-executing-a-c-sharp-source-file-in-command-prompt
39https://github.com/crud89/DotNetWithCMake
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2.0.6 Notepad++ (Notepad for Source Code)

Downloads | Notepad++40

40https://notepad-plus-plus.org/downloads/
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2.0.7 HxD (Hex Editor)

HxD - Freeware Hex Editor and Disk Editor | mh-nexus41

41https://mh-nexus.de/en/hxd/
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2.0.8 MarktextApp (Markdown Syntax Editor)

• https://marktext.app/
• https://github.com/marktext/marktext/releases
• Download latest version

– https://github.com/marktext/marktext/releases/tag/v0.17.1
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2.0.9 Cygwin (Linux environment for Windows)

• https://www.cygwin.com/
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2.0.10 Dependency Walker (32-bit or 64-bit Windows module dependency checker)

• https://www.dependencywalker.com/
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2.0.11 Doxygen (Code Documentation)

Doxygen: Doxygen42

42https://www.doxygen.nl/index.html
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2.0.12 Sonarlint (Code Quality and Code Security Extension)

https://www.sonarlint.org/

2.0.13 Codepen.io (online code sharing)

• https://codepen.io/

• CodePen is a social development environment. At its heart, it allows you to write code in the browser,
and see the results of it as you build.

• A useful and liberating online code editor for developers of any skill, and particularly empowering for
people learning to code. We focus primarily on front-end languages like HTML, CSS, JavaScript, and
preprocessing syntaxes that turn into those things
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2.0.14 Codepen.io (online code sharing)

• Credit Card Sample on Codepen
– https://codepen.io/quinlo/pen/YONMEa

• Checkout trends https://codepen.io/trending

2.0.15 Codeshare.io (real-time code sharing)

• https://codeshare.io/

• Share Code in Real-time with Developers, An online code editor for interviews, troubleshooting, teach-
ing & more…
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2.0.16 Codebeautify.org (online data conversion tools)

• Has several tools for developers (Code Formatter, JSON Beautifier, XML Viewer, Hex Converters and
more…)

• https://codebeautify.org/

2.0.17 AsciiFlow.com (ASCII drawing tool)

• Asciflow provides ascii based drawings that you can copy directly to textfiles and source codes. Visit
the following link

– https://asciiflow.com/
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2.0.18 Freemind (opensource mindmap application)

• Freemind is open source java based desktop mindmap application. Can export files to several formats

– Main Page - FreeMind43

43https://freemind.sourceforge.net/wiki/index.php/Main_Page
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2.0.18.1 Mockup Designers

• Mockflow

– Signup - MockFlow44

• Wireflow

– https://wireflow.co/

2.0.19 PlantUML (software designer)

• Text based designer for software engineers

– https://plantuml.com/

•

Participant

Participant

Actor

Actor

Boundary

Boundary

Control

Control

Entity

Entity

Database

Database

Collections

Collections

Queue

Queue

To actor

To boundary

To control

To entity

To database

To collections

To queue

• Also visit course notes that related to plantuml CE204 Object-Oriented Programming - RTEU C204
Object Oriented Programming Course Notes45

2.0.20 Drawio (drawing tool)

• Online and Offline Drawing Tool

– https://app.diagrams.net/

• Offline Installer

– Releases · jgraph/drawio-desktop · GitHub46

44https://mockflow.com/signup/
45https://ucoruh.github.io/ce204-object-oriented-programming/week-5/ce204-week-5/
46https://github.com/jgraph/drawio-desktop/releases/
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2.0.21 Putty (Remote Connection)

• Commonly use for SSH connection
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• We can run a SSH server with MobaXterm and can connect to same computer with Putty.
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2.1 Download file over SSH Protocol
• How to Download and Upload Files over SSH – TecAdmin47

Here are some useful examples for downloading files from the remote system over SSH protocol.

• This will connect to example.com server with user “username” and copy the /backup/file.zip file to
local system directory /local/dir. To use theis command replace the values as per your environment.

scp username@example.com:/backup/file.zip /local/dir

• If the SSH is running on a non-standard port, You can specify the port using -P option with SCP
command.

scp -P 2222 username@example.com:/backup/file.zip /local/dir

• If your remote server required a private key to connect server, You can use -i followed by a private
key file path to connect your server using the SCP command. This can be helpful for AWS servers.

scp -i private_key.pem username@example.com:/backup/file.zip /local/dir

2.2 Upload file using SSH
You can also upload files to the remote server using SSH protocol using the SCP command. Use the following
example command for uploading files to the SSH server.

scp file.zip username@example.com:/remote/dir

Similarity you can use -P switch to define port of the SSH server and -i to define private key for the user
authentication.

• Also you can use SSH tunnels for remote code development
47https://tecadmin.net/download-file-using-ssh/
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– Developing on Remote Machines using SSH and Visual Studio Code48

– Visual Studio Code Server49

2.2.1 MobaXterm (Remote Connection)

• Multip Purpose Remote Connection Toolkit

48https://code.visualstudio.com/docs/remote/ssh
49https://code.visualstudio.com/docs/remote/vscode-server
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2.2.2 Teamviewer (Remote Connection)

• Remote connection tool
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– TeamViewer – Uzaktan Destek, Uzaktan Erişim, Hizmet Masası, Çevrimiçi İşbirliği ve Toplan-
tılar50

2.2.3 AnyDesk

• Remote connection tool

– The Fast Remote Desktop Application – AnyDesk51

50https://www.teamviewer.com/tr/
51https://anydesk.com/en
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2.2.4 Paletton.com and Colorhunt.co (Color Chooser)

• Generates color pallettes and sample usages

– Paletton - The Color Scheme Designer52

– https://colorhunt.co/

– Also check Colors Tutorial53

52https://paletton.com/#uid=1000u0kllllaFw0g0qFqFg0w0aF
53https://www.w3schools.com/colors/
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2.2.5 Understand (Static Code Analysis)

• https://emenda.com/scitools-understand/

154



155



2.2.6 JD Project (Java Decompiler)

• Java Decompiler for Jar and Class Files, If code is not obfuscated it recover source code from compiled
files. Just drag and drop files to GUI

– http://java-decompiler.github.io/

– You can use it standalone app or with eclipse
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2.2.7 Cutter (Multi-Platform Reverse Engineering Tool)

• Cutter’s goal is to be an advanced FREE and open-source reverse-engineering platform while keeping
the user experience at mind. Cutter is created by reverse engineers for reverse engineers.

• https://cutter.re/
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2.2.8 IDA Pro / Freeware (Native Reverse Engineering Tool)

• IDA Pro as a disassembler is capable of creating maps of their execution to show the binary instructions
that are actually executed by the processor in a symbolic representation (assembly language). Advanced
techniques have been implemented into IDA Pro so that it can generate assembly language source code
from machine-executable code and make this complex code more human-readable.

2.2.9 IDA Pro / Freeware (Native Reverse Engineering Tool)

• Hex Rays - State-of-the-art binary code analysis solutions54

54https://hex-rays.com/ida-pro/
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2.2.10 IDA Pro / Freeware (Native Reverse Engineering Tool)

2.2.11 Code Visualization (Python, C , C++ , Java)

• This coding tutor tool helps you learn Python, JavaScript, C, C++, and Java by visualizing code
execution.

– https://pythontutor.com/

2.2.12 Assembly of C Code

• Multilanguage supported. Convert source code to assembly codes

– https://godbolt.org/
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2.2.13 Mobile Device Screen Sharing for Demo

• Show USB or Wifi connected Mobile Device Screen on PC and Provide Controls

– GitHub - Genymobile/scrcpy: Display and control your Android device55

– Run scrcpy for single mobile phone.

– Open Source Project - Scrcpy now works wirelessly56

2.2.14 Travis-CI

• Travis-CI is a continues integration platform

• Travis-CI free option removed for this reason, its not in our scope.

• It uses Travis.yml files for actions.

2.2.15 AppVeyor

• Another CI platform it has free option for public builds.

– https://www.appveyor.com

– GitHub - Kimserey/hello-world-nuget57

– hello-world-nuget/appveyor.yml at master · Kimserey/hello-world-nuget · GitHub58

55https://github.com/Genymobile/scrcpy
56https://www.genymotion.com/blog/open-source-project-scrcpy-now-works-wirelessly/
57https://github.com/Kimserey/hello-world-nuget
58https://github.com/Kimserey/hello-world-nuget/blob/master/appveyor.yml
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2.2.16 Jenkins

• Self-hosted solution for CI operations, Has integration with Github and several platforms.

– https://www.jenkins.io/

– https://www.jenkins.io/doc/pipeline/tour/hello-world/

2.2.17 Jenkins
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2.2.18 Jenkins

• https://www.jenkins.io/solutions/github/

2.2.19 Vagrant

• Vagrant is a tool for building and managing virtual machine environments in a single workflow. With
an easy-to-use workflow and focus on automation, Vagrant lowers development environment setup time,
increases production parity, and makes the “works on my machine” excuse a relic of the past.
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– https://www.vagrantup.com/

• Setup Development Environment with Vagrant

– Setting Up Development Environment Using Vagrant - Edureka59

– development-environment/Vagrantfile at master · gantsign/development-environment ·
GitHub60

2.2.20 Docker / Docker Compose / Kubernetes (1)

• Docker takes away repetitive, mundane configuration tasks and is used throughout the development
lifecycle for fast, easy and portable application development – desktop and cloud.

– https://www.youtube.com/watch?v=nBwJm0onzeo&ab_channel=GaryExplains Dockerfile
– https://devopedia.org/docker

• DockerHub

• Docker Compose Yaml

• Dockerrun.aws.json (AWS)

2.2.21 Docker / Docker Compose / Kubernetes (2)

59https://www.edureka.co/blog/development-environment-using-vagrant/
60https://github.com/gantsign/development-environment/blob/master/Vagrantfile
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2.2.22 Docker / Docker Compose / Kubernetes (3)

2.2.23 Docker / Docker Compose / Kubernetes (4)
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2.2.24 Docker / Docker Compose / Kubernetes (5)
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2.2.25 Docker / Docker Compose / Kubernetes (6)

2.2.26 Nuget Packages (1)

• https://www.nuget.org/packages

• What is NuGet and what does it do? | Microsoft Learn61

61https://learn.microsoft.com/en-us/nuget/what-is-nuget
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2.2.27 NuGet Tools (2)
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2.3 Managing dependencies (3)

2.4 Tracking references and restoring packages (4)
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2.4.1 SCV Cryptomanager

• SCV Crypto Manager has several tools for cryptographic operations.
– https://cryptomanager.com/download.php

2.4.2 Addario CryptoBench

• CryptoBench can be used for hash and symmetric asymmetric encryption-decryption operations.
– CryptoBench Download Page62

– http://www.addario.org/files/CryptoBench%20v1.0.1.zip
62http://www.addario.org/cryptobench/
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2.4.3 Raymond’s MD5 & SHA Checksum Utility

• Hash Calculation Utility

• MD5 & SHA Checksum Utility | Raymond’s WordPress63

63https://raylin.wordpress.com/downloads/md5-sha-1-checksum-utility/
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2.4.4 SlavaSoft HashCalc

• SlavaSoft HashCalc - Hash, CRC, and HMAC Calculator64

64https://www.slavasoft.com/hashcalc/
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2.4.5 Portable PGP

• Portable PGP uses for the generation of PGP keys to transfer files securely via e-mail or other channels.
You can encrypt or sign your documents with this tool then the receiver can open or verify your e-mail.

• https://ppgp.sourceforge.net/
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2.4.6 Online Programming Envoriments

• Hackerrank

– https://www.hackerrank.com/

• CS50 Sandbox

– https://sandbox.cs50.io/

• Programiz C Online Complier

– Online C Compiler65

𝐸𝑛𝑑 − 𝑂𝑓 − 𝑊𝑒𝑒𝑘 − 2

65https://www.programiz.com/c-programming/online-compiler/
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